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Resolutions: 
Bring ‘Em On! 
BY GAIL LIPPINCOTT 

Welcome to 2006! 
Did you make a 
few New Year’s 
resolutions? Have 
you broken any 
yet? Chapter 
presidents, like 

many people, make resolutions. Personal 
resolutions, it seems, often include losing 
weight—just check out the Sunday paper, 
loaded with coupons for low-fat foods 
and ads for exercise equipment. My reso-
lution for the Orlando chapter is just the 
opposite: I want to increase our weight in 
several areas: 

• Boost participation on the Administra-
tive Council. 

• Expand the number of members at-
tending chapter meetings by 15%. 

• Add to the number of student mem-
bers. 

We are off to a roaring start! New mem-
ber Carla Tarantino joined the Administra-
tive Council (AdCo) as manager of the 
Community Achievements Award program. 
Carla also volunteered to photograph the 
fun we have at chapter meetings. Wel-
come, Carla! You are well on your way to 
an Active Member Shirt.  

The AdCo is now up to 23 members, and 
we have a fun, productive time at our 
monthly dinner meetings at Pizzeria Uno 
(see coupon on pg. 7). We encourage any 
chapter members to join us at these meet-
ings, where the real work of the chapter is 
done. So, I’m pleased to report that we’ve 
already met Resolution #1, a goal many 
chapters envy. 

Next, to entice more members to attend 
chapter meetings, we pitch our ideas to 
 

Bonnie Spivey, PR Manager, who crea-
tively promotes the great meeting lineup 
assembled by VP Erika Higgins. Our at-
tendance varies between 30 and 45 peo-
ple, but not all are members. Membership 
manager Mark Wray and his sidekick Jen 
Selix keep track of numbers and dream 
up promotions to remind members of the 
opportunities the chapter offers. I’d like to 
see 5–7 new faces (new members as well 
as long-timers) at each meeting.  

I’m always looking to maximize effort, so 
Resolution #2 should be met this month; 
the January 24th meeting will be at UCF 
and typically draws a large crowd of 
alums and current students, setting the 
stage for Resolution #3. 

I didn’t want to quantify Resolution #3—
we had 17 student members in November 
and 21 in December, a 23.5% increase! 
Now the goal will be to keep the numbers 
up with current students renewing their 
memberships or December grads renew-
ing as full members, plus adding new stu-
dent members. As Future Technical Com-
municators (FTC) officers Alex Garcia and 
Rachel Eichen (who are also AdCo mem-
bers) spread the STC word to students 
and faculty this new semester, they’ll also 
play up the chapter’s generous member-
ship deal for new and renewing students.  

I’m optimistic that our chapter will continue 
to gain weight, especially when members 
add up the benefits they receive. Stay 
tuned to Memo to Members and the chap-
ter LISTSERV for more exciting opportuni-
ties such as scholarships, workshops, high-
school competition judging, awards, and 
gift giving. See you at a meeting!  —MtM 

GAIL LIPPINCOTT IS STC ORLANDO CHAPTER 
PRESIDENT, AN ASSOCIATE FELLOW, AND MAN-
AGER OF THE PROFESSIONAL DEVELOPMENT STEM 
FOR STC'S 53RD ANNUAL CONFERENCE TO BE 
HELD IN LAS VEGAS IN MAY 2006. GAIL TEACHES 
TECHNICAL WRITING AT THE UNIVERSITY OF CEN-
TRAL FLORIDA. 

Have an article? 
Submit a new article or 

Chapter Meeting  
summary to  

newsletter@stc-orlando.org. 
If it’s printed, you win  
a $5 chapter meeting  

discount voucher. 

http://www.stc.org
http://www.stc-orlando.org
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Tool Tips: Firefox Part Two 
BY DAVID COVERSTON 

Last year, I introduced you to Fire-
fox, a new browser that is gaining 
in popularity (Memo to Members, 
February 2005). This month, I will 
give you an update on some fea-
tures in the new version and talk 
about some of my favorite exten-
sions. 

The Firefox 1.5 download is only 
slightly larger than previous ver-
sions, weighing in at 5 MB.  Up-
dating the browser has been auto-
mated, and pop-up blocking has 
been improved. Web pages load 
faster and now you can change 
the order of the tabbed interface 
by dragging and dropping the 
tabs. Most links open on a new tab 
instead of another browser in-
stance now, so being able to ar-
range them is quite nice. 

If you enter private information on 
Web pages and you want to clear 
that information from the browser, 
you will find a new Clear Private 
Data command on the Tools menu 
makes it easy for you. 

Choose Tools > Extensions to open 
the Extensions dialog box and 

take a look. The Extensions dialog 
box has been changed so that an 
Update Now button next to an 
extension notifies you that an up-
date is available for that exten-
sion. Click the button and your 
extension update is downloaded 
and installed.  Click Get More 
Extensions to open the extensions 
Web page and you can see what 
extensions are available. There is 
a keyword search box on that 

page to make it easy to find ex-
tensions by name as well as a 
category listing to find them by 
type of extension. 

One thing I missed in the previous 
version of Firefox was Internet 
Explorer’s ability to save Web 
pages as an archive file with the 
file extension of .mht. This format 
combines all the text and images 
into one handy file. Well, now 
there is an extension that will do 
that in Firefox, the Mozilla Archive 
Format. After I took the screenshot 
in Figure 1, I updated my copy. 
This extension adds MAF MHT Ar-
chives to the File > Save As menu, 
and the file is automatically given 
the .mht file suffix. 

Another one of my favorite exten-
sions is Auto Copy (Figure 2). Auto 
Copy copies text that you select 
on a page to the clipboard. Right-
click on the list in the Extensions 
dialog box, and choose Options to 
open the Auto Copy options dia-
log box. 

(Continued on page 4) Figure 1.  Extensions dialog box. 

Figure 2.  Auto Copy options dialog box. 
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Upcoming Seminars 
 

January 25: Learn how content man-
agement works from a presenter with 
over 10 years of experience in the 
field, Bret Freeman of Vasont Sys-
tems. The free webinar “Content 
Management 101: How Does It 
Work?” will take place at 1:00 pm 
and will help attendees to under-
stand how a content management 
system manages reused information. 
Visit lra100.livemeeting.com/LRS 
Registration/EC/vasont/ 
1751668212.aspx to register and 
for more information. 

The following Web telephone  
seminars take place from 1 to 2:30 

p.m. Register at stc.webex.com. 
Please note that registration closes 

24 hours prior to the event. For 
more information, visit 

www.stc.org/seminars.asp. 

January 25: William Horton will 
present "Developing Visual Fluency." 
The seminar will help improve par-
ticipants’ ability to find the right pic-
ture to communicate a message. 

February 8: Susan W. Gallagher will 
host "Documenting APIs: Step Up to 
the Plate." Gallagher's overview of 

API (Application Program Interface) 
documentation will discuss target 
audience, possible deliverables, and 
tools for generating reference mate-
rial automatically.  

February 22: Susan Haire, Amy 
Himes, and Marella Colyvas will 
present "Improve Your Technical 
Communication Skills through Crea-
tive Writing Techniques." The pre-
senters will demonstrate how to 
adapt techniques of fiction writing 
for use in technical writing.  —MtM 

Identify this Orlando  
Chapter Member! 
ANSWER IN NEXT MONTH’S MEMO TO 
MEMBERS 

Aaw. So, that shirt dates back to 
what year, you think? 

 

Last month’s mys-
tery kid is none 
other than our own 
Mike Murray! Did 
you guess right? 

Active Membership News 
BY W.C. WIESE 

Five months into our 2005-2006 
chapter year, we have already 
awarded 259 active member 
points to 48 different members. 
Monthly meeting attendance at 
149 to date is right on the chap-
ter’s 4-year average but down 
15 percent from last year’s re-
cord pace. Be sure to check the 
calendar page of Memo to Mem-
bers (page 12) for upcoming 
meetings and programs. 

We hosted 29 members and 
guests at our December holiday 
meeting, down 8 from last year 
but 4 above our 4-year average. 

Now, about those shirts that the 
most active among you are earn-
ing… 

A total of 11 points are required 
to earn one of 20 active mem-
bership shirts at our awards cele-
bration next June. The paceset-
ters are President Gail Lippincott 
and Publicity Chairperson Bonnie 
Spivey, tied at 16. The top 6 
have already clinched a shirt 

(you’ll notice an attractive “x” 
beside their names), and the rest 
of the Top 20 are on pace to 
collect theirs. 

 

Lippincott-x Spivey-x 

Lane-x Murray-x 

Pharo-x Eichen-x 

Garcia Kessler 

Selix Higgins 

Graham Hanigan 

Wray Coverston 

Shydo Voss 

Wiese Petralia 

Bivins Kitalong 

Phipps Schenck 

 

We hope to see your name here 
next month!  —MtM 

http://www.stc.org/seminars.asp


  

I would be quite remiss if I did not 
mention the Amazing Media 
Browser. If you right-click on a Web 
page containing a multimedia file, 
and choose Amazing Media 
Browser from the context menu, the 
Amazing Media Browser dialog box 
opens. When I have had trouble 
viewing video files in the browser, 
the Amazing Media Browser has 
usually been able to play it for me. 
But the thing I like about it the most 
is that it will let me save the video 
to my hard drive. 

Occasionally upgrading to a newer 
version of Firefox will break an 
extension you have installed. When 
that happens, a message appears 
in the Extensions dialog box that the 
extension is disabled, and the text is 
dimmed. Sometimes if you wait for 
a few weeks, the Update Now but-
ton will appear, and you can get 
that extension working again just by 
clicking the button. 

Let me mention a couple more fa-
vorites before I go: Stealthier and 

Image Zoom. Stealthier will stop 
sites from putting cookies on your 
computer, and Image Zoom lets you 
control the viewing size of images 
on Web pages. This is a good ex-
tension for anyone who has vision 
problems. 

Well, I just have to mention one 
more, Enhanced Bookmark Search. 
This one is great for people who 
have tons of bookmarks. You can 
guess what it does.  —MtM 

DAVID COVERSTON IS A SENIOR MEMBER 
OF THE ORLAND-
LANDO CHAPTER. 
HE RECEIVED HIS 
M.A. IN 
JOURNALISM 
FROM UF. DAVID 
ENJOYS 
TEACHING 
OTHERS HOW TO 
BE MORE 
PRODUCTIVE, 
AND HIS TOOL 
TIPS ARTICLES HAVE BEEN REPRINTED IN 
SEVERAL CHAPTER NEWSLETTERS. 

Tool Tips (Continued from page 2) 

Page 4 Memo to Members January, 2006 

Letters to the Editor 
 

Another great job! I particularly like 
the nine-up page of "coupons" and 
miscellaneous items.  

—Dan Voss 

 

I'm a regular reader of the STC 
Orlando Chapter newsletter and 
am really impressed with what 
you've done with it. You should be 
very proud of your accomplishment! 

—Mary Kendig 

Editor’s note: I really do like to hear 
from you, and your comments help to 
make the MtM better. E-mail newslet-
ter@stc-orlando.org, and if you 
don’t want me to print your message 
(you’ve got something against being 
famous?), just let me know. 

 

What Were We Thinking? 
  

Oh my goodness, Mike Murray’s not 
running for national director, but 
international. Apologies to Mike, and  
to anyone who was confused by the 
error in December's Memo to Mem-
bers.  —MtM 

Figure 3.  Amazing Media Browser  

Society News 
PREVIOUSLY PUBLISHED HERE AND THERE 

STC is pleased to announce the 
launch of the STC Forum at  
forum.stcforum.org. You've been 
asking for a place where you can 
discuss issues of STC governance 
and broader issues of technical 
communication; you've now got 
such a place on STC's own Web 
site. Make your voice heard!   

—MtM 
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January Meeting Preview 
BY KARLA KITALONG 

Our guest speaker for the January 
24th chapter meeting, to be held at 
UCF, is Alice J. Robison. Alice is on 
the verge of receiving her doctorate 
in Rhetoric and Composition Studies 
from the University of Wisconsin- 
Madison. Her areas of research, 
though, extend beyond the tradi-
tional scope of English composition; 
in fact, one of her minor areas of 
study is curriculum and instruction. 
Her dissertation, which she expects 
to defend this spring, is about the 
rhetoric and pedagogy of video 
games. 

The tentative title for Alice’s talk is 
“Imagining Readers and Players: 
Videogame Design as a Writing 
Process.” 

Alice’s ground-breaking work at the 
intersection of writing and video 
game studies is highly regarded. 
Besides her keynote address to the 
Orlando Chapter of STC, Alice has 
given 16 presentations at home in 
Madison, Wisconsin and as far away 
as Taipei, Taiwan. She’s taught at the 
college level since 1998 and has 
worked with her university’s writing 
across the curriculum program since 
2002. 

Alice’s credentials clearly speak for 
themselves, but you might like to 
know that the co-director of her dis-
sertation is Professor James Paul 
Gee, author of What Video Games 
Have to Teach Us about Learning and 
Literacy, a book that has been very 
influential in literacy and learning 
since its publication in 2004. 

Alice’s vita is online at 
www.wisc.edu/english/graduate/
cvs/robison.pdf, and a short bio 
from one of her many conference 
presentations can be found here: 
www.glsconference.org/pop/
robison.htm 

Directions to UCF: 

From Orlando International Airport: 
Go east on 528 to 417 north. Take 
417 north (Toll Road) to exit 37 - 
University Blvd. Exit east onto Uni-
versity Blvd. to UCF. 

From Orlando Sanford Airport: 
Lake Mary Blvd to 417 south (Toll 
Road). Go to exit 37 - University 
Blvd. Turn left onto University Blvd. 
continuing east to UCF. 

From Daytona Beach on I-4:  
Exit 94 (old exit 49) onto FL 434 
east. Go through Longwood, Winter 
Springs, and Oviedo on FL 434 to 
UCF. 

From Tampa on I-4:  
Exit 72 (old exit 28) onto east 528 
(Toll Road). Go past Orlando Inter-
national Airport to 417 north. Take 
417 north (Toll Road) to exit 37 - 
University Blvd. Exit east onto Uni-
versity Blvd. to UCF. 

From South on Florida Turnpike:  
Exit 254 (Orlando South - 441). 
Take first right onto east 528 (Toll 
Road). Go east past Orlando Inter-
national Airport to 417. Take 417 
north (Toll Road) to exit 37 -
University Blvd. Exit east onto Uni-
versity Blvd. to UCF. 

From North on Florida Turnpike:  
Exit 267 onto east 408 (Toll Road). 
Go east through Orlando to merge 
with 417. Take 417 north to exit 37 
- University Blvd. Exit east onto Uni-
versity Blvd. to UCF. 

From Titusville (East Coast):  
SR 50 west past 408 overpass to FL 
434 - Alafaya Trail. Turn right to 
UCF (2 miles). 

From Melbourne:  
I-95 to exit 201 (old exit 75) - SR 
520 to SR 50 west to right on FL 
434 - Alafaya Trail or I-95 to exit 
205 (old exit 77B) - SR 528 west  
 

(toll) to 417 north to exit 37 - Uni-
versity Blvd. Exit east to UCF. 

For additional information call UCF’s 
Directions Hotline: (407) 882-0909. 
Vicinity maps are available at 
www.ucf.edu/campusmap/
vicinity.html. 

Directions to the Student Union: 

Parking near Student Union 

• At University Blvd. – enter UCF 
and turn left on Gemini Blvd. 

• Turn right at traffic signal at 
Centaurus Drive 

• Turn right at stop sign 

• Park in Centaurus Lot or West 
Parking Garage 

• Place parking pass on dash – 
facing out toward windshield 

Walking to Student Union: 

• Walk toward Burnett Honors 
College (low, one-story building, 
beyond and in-between Visual 
Arts Building and Colbourn Hall) 

• Walk past Burnett Honors Col-
lege, along the walkway to the 
right of the building 

• The Student Union is at the end 
of this walkway 

Directions to the Cape Florida Ball-
room in the Student Union: 

• Take the elevators (near Mrs. 
Fields’ Cookies) or the stairs to 
the third floor. 

• The Cape Florida Ballroom is on 
the third floor of the Student 
Union complex. 

Don’t forget to print out your park-
ing pass and a map—just in case! 

(Continued on page 8) 



  

If You Missed Our Last 
Meeting... 
BY DAVID COVERSTON 

…you missed Dan Heath and Janice 
Pizzurro of SunGard HTE Inc. pre-
senting an overview of online learn-
ing technologies. Dan is a UCF 
graduate who started as a techni-
cal writer, but now finds that he 
spends most of his time doing train-
ing materials. 

Dan highlighted four trends in online 
training: Learning/Content Man-
agement Systems, distance learning, 
blended learning, and rapid e-
learning. One of the things an LMS 
does is enable management to 
monitor the progress of employees' 
training. The software can pinpoint 
areas where employees need im-

provement, and help managers 
plan additional training accord-
ingly. Dan demonstrated the SumTo-
tal Systems LMS they are using at 
SunGard HTE. 

One of the reasons distance learn-
ing is important is because of the 
financial savings it can bring. It can 
reduce travel expenses, wait time, 
and help with scheduling problems. 
Dan mentioned that bandwidth is 
much cheaper now, so that is not as 
much of an issue as it has been. 

Blended learning is a combining of 
different mediums for instruction. 
New technologies have enabled 
new blends of media. An example 
of this is an instructor-led class in 
which the class instructions are e-
mailed to the students, and work is 
assigned online. 

Rapid e-learning has helped to 
reduce development time. In the old 
model, the SME designed the 
courseware and handed it off to a 
developer to create the e-learning 

module. In the new model, the SME 
is the primary content developer. 
The developer will create templates 
for the SME, and help him develop 
the module. 

Learning Management Systems help 
you manage information and train-
ing resources. They usually operate 
in a Web environment and track 

items such as registrations, (virtual) 
classroom size, and attendance. 
Software that can provide a virtual 
classroom includes Microsoft Office 
Live Meeting, WebEx, and Macro-
media Breeze. SunGard HTE uses 
Live Meeting's whiteboard, and 
shared applications feature in their 
training. Dan and Janice demon-
strated the whiteboard feature and 
visited a Web site while using Live 
Meeting. 

Dan closed his captivating presen-
tation by demonstrating some of the 
capabilities of the software for-
merly known as RoboHelp. Macro-
media's Captivate can record 
screen actions and save the output 
to a Flash file. The autocaption fea-
ture makes it easy to produce useful 
documentation. You really had to 
see it to appreciate it.  —MtM 
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Want to be In the Know? 

Join our LISTSERV! 
STC-Orlando’s discussion list offers 
access to hundreds of professionals 
and is an easy way to stay informed 
about chapter meetings and events. 

E-mail djones@ucf.edu to sign up. 

A percentage of your purchases 
from the following Web sites is  
returned to the Orlando chapter: 

www.amazon.com/exec/obidos/
redirect-home/orlandochapte-20 

www.cafepress.com/orlandostc 

A round table of meeting attendees listening attentively to Dan Heath’s presentation 

Dan Heath gives the online training trends 

http://www.amazon.com/exec/obidos/redirect-home/orlandochapte-20
http://www.amazon.com/exec/obidos/redirect-home/orlandochapte-20
http://www.cafepress.com/orlandostc
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We Have Lanyards! 

Stylish, cheap, and personalized 
(no more sticky name tags!), 

STC Orlando Chapter lanyards are 
a great way to showcase your 

bling! Buy yours for only $5  
at our next chapter meeting.  

Going Down Under? 
Don’t fall off the STC radar 

when you move or change 
e-mail addresses. 

Keep your STC Member Profile 
current via the member services 

section of www.stc.org. 

Send Dan Jones an e-mail to en-
sure that you don’t miss valuable 

LISTSERV announcements 
(djones@ucf.edu). Only members 

can request updates. 

New Members Only 
Job Listings! 

Richard Phipps' job announce-
ments will become “members 

only” in the Spring of 2006. If you 
are an STC Orlando Chapter 

member, you’re all set. If you’re 
not, and would like to get Rich-

ard’s often exclusive job postings, 
now is the time to join! 

Just one more great member 
benefit brought to you by your 

Orlando Chapter STC! 

 

Tenth Annual High 
School Writing 
Competition 

If you’d like to judge entries, 
e-mail Jon Kessler: 
jskessler@aol.com. 

 

Carla Tarantino 
is STC Orlando Chapter’s  

NEW PHOTOGRAPHER! 

Sit close to her at the next 
meeting! 

 

Congratulations 
to STC Orlando  

Chapter  

New Senior Member 

Beth Cunningham 

Love pizza as much 
as you love STC? 

Join us Tuesday, February 7th at 
 

PIZZERIA UNO 
4120 E Colonial/SR 50 East 

Orlando, FL 32803  
Order take-out or dine-in, 

present the coupon 
(it’s right over there! ), 

and the STC Orlando Chapter gets 
a portion of your purchase. 

EASY! 
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Peachpit User Group  
Information 
NEWS FROM PEACHPIT 

As an official User Group, STC Or-
lando Chapter members are eligible 
for a 30% discount off the list price 
of any Peachpit books. At checkout, 
right before entering your credit 
card number, just enter the user 
group coupon code  
UE-23AA-PEUF (case-sensitive). This 
coupon code is an exclusive offer 
that may not be used with other 
coupon codes. 

Find lots of interesting titles at 
www.peachpit.com. 

BOOKS FOR REVIEW 

A great benefit of membership is 
free review copies. To request a 
free book for review, send an e-mail 
to usergroups@peachpit.com. 

 
Your e-mail should list the following 
information IN THE FORMAT THAT 
FOLLOWS: 

STC Orlando Chapter (this is our 
group name)/YOUR NAME 
ADDRESS 
PHONE 
QUANTITY 
ISBN AND TITLE NAME 

Members have 90 days to complete 
a review for the Memo to Members; 
once it’s published here, it gets sent 
to Peachpit. So, not only do you get 
to keep a great book, you get a 
$5-off meeting coupon for submit-
ting an article. Sweet! 

Peachpit also likes reviewers to try 
to post their reviews to Web sites 
such as Amazon, Barnes & Noble, 
and Borders.  —MtM 

 

 

New titles from 
Peachpit... 

 

January Chapter Meeting (Continued from page 5) 

http://www.peachpit.com
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Senior Member Publishes 
Book For Kids—and Kids at 
Heart 
BY MEMO TO MEMBERS 

STC Orlando Chapter senior member 
Mary Kendig has recently written, 
designed, and self-published a book 
of poems for kids called Wonderful 
Words: Fun Poems About Words. 

The author has crafted the poems and 
designed the book to be both enter-
taining and educational. The book 
introduces children to the similarities 
among words through rhyme. It also 
uses rhyme to introduce some of the 
most basic elements of the English 
language, such as vowel sounds and 
the various parts of speech.  

Coupled with its use as an educational 
tool, the book is also designed to help 
kids celebrate, remember, anticipate, 
think, and reach out to others. Ms. 
Kendig partnered with Xlibris publish-
ers, based in Philadelphia, PA, in the 
publication of her book. In addition to 
writing the original poems, she de-
signed all of the illustrations. 

The book is intended primarily for 8 
to 13 year-olds, but is suitable for 
kids of all ages. View an excerpt at 
www.xlibris.com/wonderfulwords.htm. 

Ms. Kendig has been a writer and an 
editor for more than 25 years, work-
ing primarily in the book and maga-
zine publishing fields. She began as a 
publications editor in New York, edit-
ing trade reference books. Throughout 
her career, she has been a manager, 
editor, and writer for various publish-
ing companies, including Harcourt 
Brace, Inc., in which capacity she ed-
ited numerous elementary- and mid-
dle-school textbooks. She also spent 
several years as a Managing Editor 
with Wilson Learning Corporation, 
helping to create and deliver instruc-
tional materials in all aspects of the 
human  
resources field, including  
assessment,  
selection,  
development, and training programs.  

Mary has been a member of the STC 
Orlando Chapter since 1995 and has 
involved herself in various aspects of 
the organization. She was a member 

of an STC Orlando Chapter Newslet-
ter Advisory Committee and wrote a 
regular "Eye on Language" column for 
STC Orlando’s TechTrends newsletter 
for about four years. She has partici-
pated as a judge in the FTCC compe-
tition and presented at a local STC 
conference held at UCF a few years 
ago. 

Mary attends chapter meetings as 
often as she can—we hope to catch 
up with her soon and congratulate her 
personally!  —MtM 

Kelli Pharo entertains 
us with these cartoons 
she recently submitted 
to the Intercom humor 

contest... 

 

...too much! 

http://www.xlibris.com/wonderfulwords.htm


  

Page 11 January, 2006 Memo to Members 

Communicator Spotlight: 
Dan Heath 
BY ROSE PETRALIA 

Dan Heath is a Documentation Spe-
cialist and e-Learning Systems Admin-
istrator for SunGard HTE. SunGard 
provides a broad range of innovative 
software solutions to nearly 2,500 
government offices, agencies, and 
utility companies throughout North 
America. The company's products 
address the wireless computing re-
quirements of a rapidly changing 
public sector market and support the 
end-to-end delivery of e-Government 
access to citizens and businesses.  

That’s quite a job title—what 
responsibilities go along with 
it? 

One of the things that I like the most 
about my job is the variety of work. I 
write technical documentation for two 
of SunGard HTE’s software applica-
tions, design and maintain our Training 
& Development Web site, and work 
with subject matter experts to design 
e-learning material. I also do a great 
deal of research to help our Docu-
mentation and Training & Develop-
ment departments establish best prac-
tices and new standards. 

How did you get your start in 
technical writing? 

I was a Literature student at UCF and 
decided to take an Introduction to 
Technical Writing course to satisfy a 
general requirement. I was fascinated 
by the challenge of writing clear, con-
cise prose that was immediately acted 
upon by an audience. To me there is a 
real beauty in the simplicity and prac-
ticality of technical prose. 

I was also surprised to find that I en-
joyed working so closely with technol-
ogy. At the time I was still writing all 
of my papers on a typewriter! I  
 

 

changed the concentration of my  
English major the following semester. 
Now, learning new technologies has 
become one of my favorite parts of 
the job. 

So you segued into Technical 
Writing and decided to stick 
with it? 

I graduated from the University of 
Central Florida in 2001 with a Bache-
lor’s degree in English with a Technical 
Writing concentration. Participating in 
the Technical Writing program at UCF 
was a great experience. I was very 
lucky to have the opportunity to work 
with and be inspired by some very 
talented students and professors. I 
hope to continue my studies in the 
graduate program soon. 

Describe a normal day at  
SunGard HTE. 

It varies depending on the project I’m 
working on. I am lucky to be in a 
place where I have a great deal of 
flexibility in determining my schedule. 
The mornings are usually reserved for 
checking our Training & Development 
site’s Web analytics and catching up 
on e-mails. There are a couple of 
technical writing and content manage-
ment LISTSERVs I also frequent for 
research and new ideas. 

 

The afternoons are often used to meet 
with subject matter experts and team-
mates. I like to write and develop 
content for the Web site in the late 
afternoons and early evenings. I find 
that inspiration tends to strike me late 
in the day—so I typically find myself 
in the office long after everyone else 
has gone home, but it’s a great time to 
be productive! 

What tools do you use? 

We use Macromedia RoboHelp for 
our help documentation. Our multime-
dia documentation and e-learning 
content is done in Macromedia’s  
Captivate. We use a SumTotal learn-
ing management system to manage 
all of our learning content on the Web 
site. Of course, Microsoft Office is 
used company-wide. Personally how-
ever, I have become a big fan of 
some open source programs like 
OpenOffice and the GIMP, the latter 
of which I am using almost daily now 
for touching up graphics and images. 
For the Web site, I like to work in the 
HTML code. I’m a big fan of Macro-
media’s HomeSite editor, but lately 
I’ve been using an editor called TSW 
WebCoder. 

Do you find it’s important to 
maintain a network of tech 
writing peers? 

Absolutely! Sharing ideas with your 
peers is crucial to professional devel-
opment. I feel it is even more impor-
tant in emerging and developing 
fields like Technical Communication, 
where peer networks help to shape 
the future of the industry by establish-
ing best practices and trends. Also, 
our direct connection to the ever-
changing world of technology makes 
it important to stay current.  —MtM 

ROSE PETRALIA GRADUATED WITH A BA IN 
TECHNICAL WRITING FROM UCF LAST 
MAY. SHE WRITES SIMULATION AND TRAIN-
ING MANUALS FOR DEI SERVICES CORPO-
RATION IN WINTER PARK, FLORIDA. 
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Here we go—another year in the 
works! Like Gail Lippincott, our 
forward-thinking president, a lot of 
us have resolved to make our lives 
better in 2006. While your per-
sonal goals are all yours, if you’re 
newly resolved to perk up your 
professional skills, you’re in the 
right place. 

We’re technically already halfway 
through our program year, but 
we’ve still got a lineup of interest-
ing characters bringing their ex-
perience and energy from far and 

wide. Catch this month’s speaker, 
Alice Robison, at our annual UCF/
STC joint meeting and maybe 
learn something new about video 
games (besides what level your 
kid’s trying to beat this week...).  

And don’t discount the power of 
networking! Take advantage of 
our LISTSERV, or simply chat up 
your neighbor at the next meet-
ing—you might be surprised what 
new knowledge you’ll take home 
with you. See you at a meeting 
soon!                                       

Mark Your Calendars: 
 

01/24 Chapter Meeting. Rhetoric of 
Videogame Design with Alice 
Robison, University of Madison 
WI. UCF Student Union, 6:30 
p.m. 

01/25 Content Management 101: 
How Does It Work? Webinar, 
1:00 p.m. 

01/25 Developing Visual Fluency 
Web Seminar, 1:00 p.m. 

02/08 Documenting APIs: Step Up to 
the Plate. Web Seminar, 1:00 
p.m. 

02/18 Seminole County Regional Sci-
ence, Math, & Engineering Fair  

02/21 Dr. Nelson Ying Orange 
County Science Exposition  

02/22 Improve Your Technical Commu-
nication Skills through Creative 
Writing Techniques. Web 
Seminar, 1:00 p.m. 

02/28 Chapter Meeting. Writing for 
Online Media vs. Print Media 
with Ian Koss, Ink 19 editor. 
Winter Park Civic Center, 6:30 
p.m. 

04/20 State Science and Engineering 
Fair 

From the Editor’s Desk... 

Corner of Distinction 

Congratulations to senior member Dr. Sherry 
Steward of DEI Services Corporation and her 
colleague, UCF Assistant Professor Dr. 
Rudy McDaniel. Their book chapter, 
“Assessing the Professional Implica-
tions of the Broadband Divide,” will be 

published in the forthcoming anthology, Digital Citi-
zenship: Design, Documentation, and the Divide, by 
Adrienne Lamberti and Anne Richards. 
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